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Installation

Sartorius NICE Label Express Setup

To install the Sartorius NICE Label Express program or
to change setup configurations, run the “Setup” program
from the CD.  Make sure you close all other applications
first.

When the setup program starts, you are prompted
to select the working language.  Select the desired
language by clicking on it in the “Choose language“
dialog box.  Then click on the “Next“ button to proceed
with the setup.

The “Welcome” window tells you how to start the
installation.  It also contains the copyright warning.
Click on the “Next“ button to proceed with the
installation.

Enter the user name and, if desired, company name
in the “User information” window.  If this information
already exists on your computer, the existing names
are the default entries in this window.
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In the “Install options“ dialog box, choose the destination
folder for installation of the Sartorius NICE Label Express
program.  The program will create the required
subdirectories for the application, printer drivers and
accompanying files.  The default path for installation is

“C:\ProgramFiles\EuroPlus\Express”.

To select a different installation path, click on the “Set“
button and browse for the desired folder.

When you have selected the destination folder, click on
the “OK“ button to return to the Install options dialog box.
Then click on the “Next“ button to proceed with the
installation.

The program then displays the “Current Settings,”
including user name, system platform, defined path,
available disk space and required disk space.  The
typical installation requires about 9 MB of hard disk
memory.

If you want to make any changes at this point, click on
the “Previous“ button to return to the previous dialog box,
or end the installation program.  To continue, click on the
“Next“ button.  The installation program copies all files to
the selected folder and creates the “Sartorius NICE Label
Express“ group, which contains „Sartorius NICE Label
Express“ and Setup icons.  If you have a thermal printer,
you need to install the printer driver.  The instructions
for this are described in another section of this manual.

Installation
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Reinstall

Run the “Reinstall” program if you need to re-install
missing or faulty files or repair a damaged installation.

To do this, double click on the “Setup” icon in the
“Sartorius NICE Label Express“ group, or open the
Control Panel from the “Settings” item in the Windows
“Start” menu, select “Software,” click on the “Install/
Deinstall” tab and then click on the “Add/Remove“
button.

Select the desired language and click the “Next“ button
twice.  Select the “Reinstall“ option.

The program then displays the “Current Settings,”
including user name, system platform, defined path,
available disk space and required disk space.

To continue, click on the “Next“ button.  The installation
program copies all files to the selected folder and creates
the “Sartorius NICE Label Express“ group with “Sartorius
NICE Label Express“ and Setup icons.

Remove All

Use this option only if you are sure you want to remove
all Sartorius NICE Label Express files from your computer.

To start the de-installation procedure, double-click on the
“Setup” icon in the “Sartorius NICE Label Express“ group,
or open the Control Panel from the “Settings” item in the
start menu, select “Software,” click on the “Install/
Deinstall” tab and then click on the “Add/Remove“
button.

The program then displays the “Current Settings,”
including user name, system platform, defined path,
and available disk space.

During the de-installation procedure, the program asks
whether shared files should be deleted or not, as these
might be used by other programs on your computer.

To delete shared files, click on the “Yes“ button.

If you do not want to delete shared files, click on the
“No“ button.

The de-installation procedure removes the program
and the icons from your computer.  Afterwards, it asks
whether you wish to restart the computer right away.
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Quick Start in Sartorius NICE Label
Express

General Description of Label Design

If you have never worked with Windows before, or if you
are not familiar with the terms used in Windows and in
Windows applications, please read the following
sections. They provide brief descriptions of some of the
standard Windows features and explain the terms that are
used in Sartorius NICE Label Express.

If you are familiar with Windows, please proceed directly
to the chapter entitled “Starting Sartorius NICE Label
Express”.

Windows and documents

“Windows” is an operating system for personal com-
puters.  It is named for its concept of windows; everything
that goes on in the computer can be viewed in
one or more windows.

Your applications (or programs) must be able to open and
close various windows and must contain enough
programming logic to recognize what operations can
be performed when working with the contents of the
various windows.  Applications usually open one or more
documents (generic term for files, which may contain text,
numerical data or graphics) for processing.  Generally,
one document is opened in one window.

SDI and MDI applications must be mentioned briefly here.
SDI stands for “Single Document Interface” and MDI for
“Multiple Document Interface.”  SDI applications open
only one document per window; in other words, you
cannot have more than document opened at a time in a
given window.  MDI applications can work with several
documents at the same time.  Sartorius NICE Label
Express is an MDI application.

If you need more information about working with
Windows, please read the Windows Help. If you do
not need additional information, proceed to “Editing”.

Editing

Any time you change something in a document, you
are “editing” the document.  There are a few common
operations which are available in most Windows appli-
cations.

One commonly used operation is to copy information
from one part of a document to another.  To do this, mark
the object you wish to copy (this may be text, an image,
etc.) and then use the “Copy“ command (for more infor-
mation, see “Copy“ on page 28).  Then position the

Quick Start in Sartorius
NICE Label Express
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cursor where you wish to add the copied element and
use the “Paste“ command (for more information, see
“Paste“ on page 29) to insert the copied element at the
cursor position.

To move information from one part of the document to the
other, use the “Cut“ command (for more information, see
“Cut“ on page 28) followed by “Paste“.  You can also
delete information (for more information, see “Delete“
on page 29) if you do not need it anymore.

Now that you are familiar with the basic editing
functions, proceed to “Creating and editing documents/
objects”.

Creating and editing documents/objects

In addition to changing and saving existing documents,
you will also need to create and edit new ones.  To do
this, select the “New“ command.

Today’s software applications offer additional help when
creating and editing objects.  One of the most useful
forms of assistance is offered by subprograms known as
“Wizards.” These are usually series of dialog boxes that
guide you through several steps to create new objects or
edit existing objects in your document.  One especially
helpful and easy-to-use Wizard in the “Sartorius NICE
Label Express“ application is the “Label Setup Wizard“
(for more information, see “Label Setup Wizard“
on page 23).

Graphic applications like “Sartorius NICE Label Express“
also offer functions (known as “Tools”) for editing existing
objects in the document.  Changes you can make include
aligning, resizing, changing font and color and, in the
case of “Sartorius NICE Label Express,“ changing
barcode type, etc.  Objects have different properties
depending on their type (for example, text objects have
font, size, style and other properties) and there are
various ways to change them.  These functions are
described in “Useful tricks and shortcuts”.

Useful tricks and shortcuts

Changing object properties

You can use your mouse to change object properties.
Select an object by clicking on it.  Then click the right
mouse button (or if you are left-handed, the left button) to
open a handy pop-up menu.  This menu contains various
functions, depending on type of object selected.

Moving an object to a new position

To move an object to a new position, first click on it, then
click on it again and hold down the mouse button; when
you move the mouse, the object moves (this is called
“dragging”).  When you are satisfied with new object
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position, release the mouse button (this is called “drop-
ping;” the whole operation is known as “drag and
drop”).

Getting more information

If you do not understand an option (especially in dialog
boxes), click on the Help button or select the “What’s
this?” option from the pop-up menu.  To activate this pop-
up menu, click first on the question-mark icon in the upper
right-hand corner of the dialog box, move the mouse to
the desired object and click on the object (for example,
the text field for creating an operator prompt) that you
want to know more about.

Useful Windows shortcuts

Shortcuts are usually combinations of keys you can press
to activate functions without having to use your mouse.
Sartorius NICE Label Express has several special menu
shortcuts (for more information, see “Menu Shortcuts” on
page 20) for users who prefer working with keyboard;
other shortcuts are available at all times (for more infor-
mation, see “General Shortcuts” on page 20).

There are also mouse shortcuts, usually available by right-
clicking (or left-clicking, if you are left-handed) your mouse
on a selected object.  This activates a handy pop-up
menu from which you can select shortcuts for various
tasks.  You will probably use this shortcut in “Sartorius
NICE Label Express“ quite often.

Now that you have learned about Windows or refreshed
your memory, you are ready to begin designing labels.
Begin with “Starting Sartorius NICE Label Express” or go
directly to the chapter entitled “Designing your first label”.

Starting Sartorius NICE Label Express

When you start Sartorius NICE Label Express, the Wizard
“Welcome” dialog box helps you to open
a label in one of three different ways:

– Create a new label: Select this option to create
a new label.

– Open recently used label: Select this option to open
one of the 4 most recently opened labels.

– Open another existing label: Select this option
to execute the “Open“ command and browse the
label files.

Once you select the desired option and click on the
“Finish“ button, the main program window is opened.

If you selected “Create a new label,“ the „Label Setup
Wizard“ starts, allowing you to specify the label and
printer you want to use.

Quick Start in Sartorius
NICE Label Express
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Description of the Main Window

To view a brief description of an icon, position the mouse
cursor over the icon and wait for a couple of seconds.
A “Tool tip” tells you what the icon is for.

Because “Sartorius NICE Label Express“ is an MDI (multi-
document interface) application, you can work with more
than one label at a time.  When only one label (docu-
ment) is opened, it can be maximized and the name
of this label appears on the “Title bar.”

Title bar

This is the horizontal bar at the top of “Sartorius NICE
Label Express“ main window that shows the name of the
application and the name of the opened document/
label.

Menu bar

The menu bar shows the names of the seven main menus:
“File“, “Edit“, “View“, “Object“, “Options“, “Window“
and “Help“.  Each menu contains sets of commands for
designing and printing labels.

Main toolbar

Under the menu bar, there is a row of icons which
represent shortcuts to the following commands: “New
label“, “Open“, “Save“, “Cut“, “Copy“, “Paste“, “Undo“,
“Redo“, “Print“, “Translate“, “Load“, “View page“,
“View label“, “View element“, “Toolbox“, “Text tool“,
“Align tool“, “Color palette“ and “Contents“.

Text toolbar

Below the main toolbar, there is a text toolbar for
selecting font type and font attributes.

Toolbox

On the left-hand side of the window is a vertical toolbar
known as a toolbox.  By clicking on the icons here you
can insert text, barcode or line objects on the label.

Align Tools

On the right-hand side of the window there are icons for
aligning objects.  You can use these tools to align (justify)
the selected objects on the label to the left, right, or in the
center.

Information bar

The information bar at the bottom of the window shows
the co-ordinates of the current mouse cursor position,
as well as the selected printer.  By double-clicking on the
printer name, you can quickly access the Printer setup
dialog box; for instance, if you wish to change printers.
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Ruler bars

When the label file is opened, ruler bars are shown
along the upper and left-hand screen border, giving the
horizontal and vertical co-ordinates in the selected units
(cm, mm or inches).  The position (x and y co-ordinates) of
the mouse cursor on the screen can be traced on the ruler
bars.  The size and position of each selected object on
the label is also shown as a shadow on the ruler bars
when you move the object, to help you position the
object.

The unit of measurement on the rulers is cm, mm or
inches.  You can change the unit by clicking on the unit
button (in the upper left-hand corner of the label area).

Horizontal scroll bar

This scroll bar allows you to move the contents of the
active window to the left or right to view the objects
that do not fit into the label viewing area.

Vertical scroll bar

This scroll bar allows you to move the contents of the
active window up and down to view the objects that
do not fit into the label viewing area.

Document window

This is where documents (labels) are opened and where
you create your labels.

Quick Start in Sartorius
NICE Label Express
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Designing Your First Label

You will now create your first label, containing five text
objects and two graphics, as well as line, box and
inverse objects.

This label is saved on your computer under the name
SAMPLE.LBL; the picture is in the SAMPLE.PCX file.

Start “Sartorius NICE Label Express“ and select the
“Create new label“ option from the Wizard dialog box.
Click on the “Finish“ button to confirm your selection.

The “Label Setup Wizard“ dialog box is opened.

Select the desired printer from the drop-down list
and click on the “Next“ button to continue.

Then select the type of weighing display and control unit
(for example, “isi-10“ or “isi-20“) that you are using
and the event that triggers the print function.  Click
on the “Next“ button to continue.
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Click on the “Next“ button again to skip automatic
definition of the label from predefined stocks and
advance to the paper selection step.  Note that this step
is only available if you selected a non-thermal printer,
such as a laser or ink-jet printer.

Select the desired paper size (in this example, A4).

Click the “Next“ button and enter the label dimensions;
for this example, enter 10 cm for the width and 7 cm
for the height.  Click on the “Finish“ button to confirm
the definition.

Adding the first text field to the label

1. Select the font, style and size for the text from the
text tool.  For this example, use ”Arial, bold, 20 pt.”

2. Click on the  icon.  Move the mouse to the position
where you want to insert the text and click.

3. Enter the text you want to print; in this example,
“Sample1”.

4. Press <Ctrl> + <Enter> to finish entering the text
and create the text object.  If you just press <Enter>,
this creates a new line within the active text object.

5. You can change the position of the text object later
using the “drag-and-drop” procedure explained
above. Double-click on the object to continue
processing.

Adding text fields to the label

Repeat the steps given above to add other text objects
to the label.  If you want to write the text in two lines,
press the <Enter> key at the end of the first line.

Adding a picture to the label

For this example, use the pictures in the SAMPLE.PCX file,
included with the program.

1.  Click on the  icon in the toolbox and move the
cursor to the position of the label where you want
the picture.  Click on the left mouse button; the
“Open“ dialog box is displayed.  Select the
SAMPLE.PCX file by double-clicking on its name.
The picture is shown on your label.

2.  Now re-size the picture to make it smaller.  First, select
the picture by clicking on it.  Then position
the mouse cursor on one corner of the picture until
the cursor changes from a pointer to a bi-directional

Quick Start in Sartorius
NICE Label Express
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arrow.  Now press and hold down the left mouse
button while moving the cursor towards the center
of the picture.  When you are satisfied with the size,
release the mouse button and the picture size
changes.

Adding a line

1. Select the  icon from the toolbox and move
the mouse below the text object “Sample1.”

2. Press the mouse button and move the mouse
to the right, while holding down the button.  When
the mouse has reached the end of the text object,
release the mouse button and the line is drawn.

3. You can change the position of the line and its thick-
ness by selecting the line and using “drag-and-drop”
to move the “handles” that appear.

Inverting black and white on a part of the label

1. Select the  icon from the toolbox.

2. Move the mouse to the upper left-hand corner of the
label.

3. Click and hold the mouse button and move the mouse
until you reach the lower right-hand corner of the part
you want inverted, so that the portion of the object
you wish to invert is enclosed (see the example shown
above).

Adding a box

1.  Select the  icon and move the mouse to the upper
left-hand corner of the graphic.  Press the mouse
button and move the mouse to the right while holding
down the button.  When the graphic object is com-
pletely enclosed, release the mouse button and the
box around the graphic is drawn.

2.  You can change the position of the box by selecting
the box and using “drag-and-drop” to move the
handles.

Saving the label

Save your design by clicking on the  icon in the tool-
bar.  Enter the name, for instance TEST, in the “File name“
field.



15

Printing the label

You can print the label by clicking on the  icon in the
toolbar or by selecting the “Print“ command from the
“File“ menu.

Note that the printer must be connected to the computer,
not to the display and control unit of the weighing
instrument.  Only one label is printed.

If you have any printing problems, see the section entitled
“Printer does not print” on page 52.

Designing a Label with Variable Objects

You will now design a label containing variable
(non-static) data.  The label will contain, among
other objects, the article number and barcode.

The article number and barcode content will vary from
label to label.  The weighing display and control unit
provides the contents of the variable field at the time
of printing.  You can include various data, such as net
weight, gross weight, current date and time, IDs, etc.

Note: When you use variable fields to print data from the
weighing display and control unit, only the printer’s
internal fonts and barcodes can be used.

Adding a variable text object

You already know how to design text objects.  Now you
will define a variable text object.

1. Click on the text icon with the question mark .
This question mark means that the new text object
will have variable contents.  Click on the label in
the position where you want the text object inserted.
The Text Wizard dialog box is shown.

2. Select the “Print Date“ option and click on the “Next“
button.

3. The object will show the current date at the time
of printing.  On screen, only the predefined date
is shown.

Quick Start in Sartorius
NICE Label Express
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Adding a variable barcode object

Now add the Interleaved 2of5 barcode to the label,
with variable barcode data.  The numbers represented
in the barcode are written below the barcode.

1. Click on the  icon and move the mouse cursor to
the desired position on the label.  If you click the left
mouse button, the “Barcode Wizard“ will help you
to define the barcode parameters.

2. Click on the “Define“ button and then on the “Gene-
ral“ tab.  Select “Interleaved 2of5“ from the list.

3. Click on the “Auto translation“ tab and choose “Below
the barcode.“

4. Click on “OK“ to return to the “Barcode Wizard“
dialog.

5. Check the Variable contents and click the “Next“
button.

6. Select the option you want to have represented by
barcode and click on the “Next“ button.  Note that
the variable field length must match the number
of characters in the barcode, unless the barcode type
supports a variable number of characters (as “Inter-
leaved 2of5“ does).

7. Click on “Finish“ to insert the barcode on the label.

8. The barcode object is still selected; click on the 
icon to rotate it 90° counter clockwise.

9. If you are not satisfied with the position of the bar-
code, select the object by clicking on it and move it
while holding down the mouse button.

If you need to change anything on the barcode object,
double-click on it and the “Barcode Wizard“ dialog box
will be displayed, allowing you to change barcode
properties.

Printing the label

The label is now finished. You can print the label

by clicking on the  icon in the toolbar, or by selecting
the “Print“ command from the “File“ menu.

If you have any printing problems, see the section
entitled “Printer does not print” on page 52.
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Working with Sartorius NICE Label
Express

How to...

Optimize printer speed

There are many factors that affect the printing speed.
By following the guidelines below you can significantly
increase printing speed.

– If your printer supports both parallel and serial ports,
use the parallel port.  A computer can transmit data
to a printer over a parallel port much faster than over
a serial port.

– Use the printer’s internal fonts instead of Windows’
TrueType fonts.  TrueType fonts are transmitted to the
printer as graphics rather than as text characters,
which means several kilobytes are transmitted rather
than just a few hundred bytes.

– Avoid using graphics on labels.

– When working with barcodes, make sure that they are
not printed as graphics (assuming your printer supports
barcode printing).

– Set the printer to a faster speed (if it supports such an
option). Note that setting the printing speed usually
affects the quality of printing.  The higher the speed,
the lighter the printout.  You need to find an accept-
able compromise between speed and quality.

– Do not print too much data on labels.  If the speed
of printing is an important factor, you should consider
using preprinted labels, and print only the data that
changes for each label.

Centering an object on a label

Select the object and the click on the  (vertical center)

or  (horizontal center) icon in the “Align” toolbar.

Hold down the <Ctrl> key when you click on an “Align”
button.  This will force alignment of the object to the
label.  If you do not hold down the <Ctrl> key, and more
than one element is selected, they are aligned relative
to each other.

Working with Sartorius
NICE Label Express
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Changing label dimensions

Double-click on the label or use the “Label Setup“
command from the “File“ menu.

Changing printer setup (format, speed)

Double-click on the label or use the Label Setup command
from the “File“ menu.  Then click on the “Previous“ button
to move to the first page of Wizard, where you can
change the printer and its properties
(“Print Setup“ button).

Restoring deleted objects

Use the “Undo“ command from the “Edit“ menu or click

on the  icon.

Designing a UCC/EAN 128 barcode

In the next example, you will design a pallet label with
text, logo, lines and a UCC/EAN barcode.  The UCC/
EAN 128 barcode must include both the serial shipping
container code (SSCC) and a variable batch number.
With “Sartorius NICE Label Express”, the UCC/EAN
128 barcode can contain only fixed (not variable) data.

If you have any problems designing the text, line or
graphic objects, see “Quick Start in Sartorius NICE
Label Express” on page 7.

UCC/EAN 128 barcode

1. Select the  icon and click on the label where you
want to insert the barcode.

2. Click on the “Define“ button to define the barcode
and select UCC/EAN128.  Click “OK“ to return
to the “Barcode Wizard“ dialog box and then
“Next“ to advance to next page.

3. Define the first part of the barcode – the batch
number.  Select “10 Batch or Lot number” from
the list of application identifiers.

4. Enter the application identifier and click on the
“Next“ button.

5. Click on the “Add“ button to define the second part
of the barcode – the serial shipping container code.
Select “00 Serial Shipping Container Code” from the
list of application identifiers, click on “Edit“ and then
select “Fixed“ and enter the value
– e.g.  354123451234567892.
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6. Click on the “Finish“ button; the UCC/EAN 128
barcode is created.

Print the label

Select the “Print“ command from the “File“ menu.

Variable Fields

You may want to print labels on which the data is differ-
ent for each label; for example, to utilize a counting
function, for serial numbers, or to include the date and
time.  To accommodate changing data, “Sartorius NICE
Label Express“ can easily be used to format labels with
variable fields.  Variable fields can be used with both text
and barcode objects.

There are several types of variables you can choose from.
Variable data is retrieved from the weighing display and
control unit at the time of printing.

Variable data

If you want to use variable data on your labels, select
the “Variable text/Variable barcode data” option in the
Text or Barcode Wizard, and click on the “Next“ button
to define the variable field.

You can select the type of data in the dialog box shown
above.  The list box contains a choice of field names for
data retrieved from the weighing display and control unit
at the time of printing.  Which fields are offered here
depends on the event selected in the Label Setup Wizard
to trigger printing.

You can also click on the “Advanced“ button to change
the format of the data fields; however, you should only
use this function if you are familiar with the program and
the weighing equipment.  Data entered in an invalid
format will not be recognized by the weighing display
and control unit.

You can only work with variable data if a printer
is connected to the weighing display and control unit.

Working with Sartorius
NICE Label Express
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Reference

Shortcuts

General Shortcuts

<Delete>: deletes selected object

<Shift> + <Delete>: Cut

<Ctrl> + <Insert>: Copy

<Shift> + <Insert>: Paste

<Alt> + <Backspace>: Undo

+ (on numeric pad): Zoom In

- (on numeric pad): Zoom Out

<Alt> + <Shift> + <Backspace>: Redo

<Ctrl> + T: Rotate 90°

<Ctrl> + A: Align

<Ctrl> + X: Cut

<Ctrl> + C: Copy

<Ctrl> + V: Paste

<Ctrl> + Z: Undo

<Ctrl> + Y: Redo

<Ctrl> + N: New

<Ctrl> + O: Open

<Ctrl> + S: Save

<Ctrl> + P: Print

Menu Shortcuts

<Alt> + F: File Menu

+ N: New label

+ O: Open…

+ C: Close

+ S: Save

+ A: Save As…

+ L: Label Setup

+ P: Print…

+ M: Compile

+ D: Download

+ X: Exit (or <Alt> + <F4>)
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<Alt> + E: Edit Menu

+ U: Undo (or <Ctrl> + Z)

+ R: Redo (undo the Undo command)
(or <Ctrl> + Y)

+ T: Cut (or <Ctrl> + X)

+ C: Copy (or <Ctrl> + C)

+ P: Paste (or <Ctrl> + V)

+ D - Delete (or <Delete>)

+ E - Select All

<Alt> + V: View Menu

+ I: Zoom in (or +)

+ O: Zoom out (or -)

+ Z: Zoom Dialogue

+ T: toggle display of Toolbox

+ C: toggle display of Color palette

+ E: toggle display of Text toolbar

+ A: toggle display of Align toolbar

<Alt> + O: Object Menu

+ T: select Text tool

+ W: Weight block tool

+ B: select Box tool

+ L: select Line tool

+ I: select Inverse tool

+ G: select Graphics tool

+ R: select Barcode tool

+ S: select Select tool

<Alt> + P: Options Menu

+ L: display Language dialogue

<Alt> + W: Window Menu

+ C: Cascade

+ T: Tile

+ I: Arrange Icons

+ L: Close All

<Alt> + H: Help Menu

+ C: Contents

+ U: Using Help

+ A: About (program information) window

Reference
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File Menu

When you select the “File“ menu in the menu bar, a list of
commands appears.  These are for opening, saving and
closing label files, activating printer functions and exiting
the program.

New label

To start designing a new label, select the “New label“

command from the File menu or click on the  icon.

This opens the “Label Setup Wizard“ dialog box, where
you can define label dimensions and change the printer
setup.

Open

This command opens an existing label file.  The default
label folder is
“C:\ProgramFiles\Europlus\SartoriusExpress\Labels.“
To open a label file which has been saved in a different
folder or on a different drive, use the Windows browse
function.

The “Preview” function can help you find the desired
label.  This function displays the selected label in the
lower left-hand corner of the “Open” dialog box, along
with the label title and description.

Once you have found the desired label, open it by
double-clicking on its name or by clicking on the “Open“
button.

Close

Select this item to close the active label file.

If the label has been edited but has not been saved since
the last change was made, the program asks whether you
want to save the changes.

If the label file has no name and you want to save
the changes and close it, the “Save As“ dialog box
is opened.

Save

This command saves the active label in the current file.
If no filename has been defined, the “Save As“ dialog
box is opened.
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The “Save“ command can be also accessed directly

through the  icon.

Save as

Select this command if you want to name a new label or
if you want to save an existing label under a new name,
in another folder, or on another drive.

The default folder for saving labels is
“C:\ProgramFiles\Europlus\SartoriusExpress\Labels.“
If you want to save the label to a different folder or drive,
use the Windows browse function to define the target
folder.

Enter the name of the label in the “File name“ text field.

Labels are normally saved in NICE Label format with the
extension “.lbl”.  You can define a different extension, but
you must also specify this extension to open the label file
again.

Label Setup

If you want to change label parameters, such as the
dimensions or format, select the “Label Setup“ command
from the File menu or double click on the label.  The
“Label Setup Wizard“ dialog is started.

Label Setup Wizard

With the Label Setup Wizard you can define the
dimensions of the label, change printer settings, and
define the event that triggers printing.  These changes can
be made in a few simple steps.

Reference
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Changing Printer Setup

Select the desired printer and, if you want to set the
printer parameters, click on the “Printer Setup“ button.
The “Printer Setup“ dialog box is opened, allowing you to
set printer parameters such as speed, quality and
direction.  Note that this is the standard Windows printer
setup dialog box and the options available may differ
depending on the printer installed.

When you are satisfied with the settings, click on the
“OK“ button to return to the “Label Setup Wizard“ dialog
box.

Click on the “Next“ button to continue with the Wizard.

If you selected a printer that can print on both sheets and
rolls of labels, Sartorius NICE Label Express will ask you
to select the desired option on the next Wizard page.

Select the print trigger

On this page you can select the event that triggers the
printing (for example, pressing the print key), as well
as the type of weighing display and control unit
connected (for example, isi20).

Note that the print trigger shown here (“Print“ Key) is the
default value.  You can change it at any time by entering
a different name for the script that is stored on the
weighing display and control unit.

Selecting label stock

If you use one of the standard predefined label formats,
you can specify this format here.  Click on the “Select
label stock“ button and select the desired label format
(stock).  This has the same effect as filling in the values
for the page size and label format on the last page of
the Label Setup Wizard.

A number of label stocks are saved in the
“C:\ProgramFiles\Europlus\SartoriusExpress\Stocks“
folder.  If the “Preview“ option is checked, the selected
stock is displayed in the preview box.

Click “Next“ to advance to next page.
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Choosing the page size

If you selected a printer other than a thermal-transfer
printer, you must enter the paper size.  Note that there
can be several labels on one sheet of paper.

Defining dimensions

Here you can enter the width and height of the label.
To accommodate the dimensions of your definition, you
can select the unit of measurement (mm, cm or inches)
by clicking on the “Unit“ button.

Note that these values are entered automatically if you
selected “Label stock” before.

If you have several labels on one page, you must also
specify the number of labels per page as well as the
positions of the labels and of the gaps between labels
on a sheet.

The preview of the page is shown on the right-hand side
of the dialog box.

When you are satisfied with the label dimensions, click
on the “Finish“ button to exit the Label Setup Wizard.

Print

Select the “Print“ command from the File menu to print the
active label.

Note that only one label is printed, and any variable
data fields will contain the default values.

Compile

This command compiles the label file so that the weighing
display and control unit can interpret it
and send the correct data to the printer without being
connected to computer. You can also activate this

command by clicking on the  icon.

Before the label data can be compiled, it has to be
saved in an auxiliary file (called a script file); otherwise
changes in the label will not be stored in the weighing
display and control unit.

Reference
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The compiling process consists of several steps:

1.  Creating the script file:

Click on the “Create“ button to create the script file.
This is the source file containing the data necessary for
retrieving the variable data from the weighing display
and control unit.  This file is created automatically based
on the elements in the label.  You can also edit this file by
clicking on the “Edit“ button; however, you should only
use this function if you are familiar with the program used
in the weighing display and control unit.

If you enter a number greater than 1in “Quantity“ field,
the script will be created and compiled in such way that
multiple labels are printed when printing is triggered. If
the printer used supports this option, you may select
Printer CopyPrinter CopyPrinter CopyPrinter CopyPrinter Copy  to use the multiple label feature of the
printer. Otherwise the scale/indicator will send the label
to the printer multiple times. As this takes more time, you
should select the option Printer CopyPrinter CopyPrinter CopyPrinter CopyPrinter Copy  whenever possible.

2.  Compiling the script file:

The script file must be compiled into a form that can
be saved on the weighing display and control unit.
To do this, click on the “Compile“ button.

3.  Downloading the compiled file:

In order for the weighing display and control unit to use
this file (and print labels) the file must be downloaded
to the weighing display and control unit.  Click on the
“Download“ button to open the “Download“ dialog box.

Alternatively, you can click on the “Make“ button to have
all three commands automatically processed in series
automatically.
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Download

You can use this command to download compiled binary
label files to the weighing display and control unit.  You

can also activate command by clicking on the  icon.
Remember that the binary label file must first be created
with the “Compile“ command.

Indicator type: This field shows the weighing display and
control unit type selected in Label Setup.

Indicator port: Select the serial interface port that the
indicator is connected to.  If the wrong port is selected
when you try to download a file to the weighing display
and control unit, an error message is displayed and this
dialog box is opened again.

Binary file: Select the binary label file that is to be down-
loaded to the weighing display and control unit.  This
option is usually already set correctly; you normally do
not need to change it.

Indicator file: Enter the name under which the binary file
will be saved in the weighing display and control unit.
This name is based on the event that activates printing –
every event has its own indicator file name.

In order to be able to download files, you must first
connect the computer to the weighing  display and
control unit.  To do this, click on the “Connect“ button.
You can disconnect from the weighing display and
control unit by clicking on the “Disconnect“ button.

If connected, the downloaded files are shown in the
“Existing files“ list box.  Normally only the user-down-
loaded files are shown.  If you want to view all files
(including system files), select the “Show all files“ option.

Download button: Click on this button to download the
selected binary file to the weighing display and control
unit under the name that is entered in the Indicator file
field.  If a file with that name already exists, a message
is shown asking if you want to overwrite the existing file.

Delete button: This button deletes the currently selected
indicator file from the weighing display and control unit
memory.

Click on the “Close“ button to close this dialog box.

Reference
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Recently used files

At the bottom of the pull-down menu, the filenames
of the four most recently edited labels are shown
for quick selection.  Selecting the file here has the same
effect as choosing the “Open“ command from the File
menu and selecting the file there.

Exit

Use this command to end the “Sartorius NICE Label
Express“ program.

Alternatively, you can activate this command from the
computer keyboard by holding down the <ALT> key and
pressing <F4>.

Edit Menu

When you select the “Edit“ menu in the menu bar,
a list of commands appears.  These commands are
for designing the label.

Undo

The “Undo“ commands cancels up to 10 of the most
recently processed commands or actions.  If you do not
like the results of a command, or have accidentally
deleted some elements, choose the “Undo“ command
as the next action to restore the previous design.

You can also activate the “Undo“ command by clicking

on the  icon on the toolbar.

Redo

Use the “Redo“ command to undo up to 10 of the most
recent “Undo” commands.

You can also activate the “Redo“ command by clicking

on the  icon on the toolbar.

Cut

Use the “Cut“ command to remove selected object(s)
from the active label.

Select an object by clicking on it.  To select additional
objects, press and hold the <Shift> key while clicking
on each additional object.
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The cut objects are stored in the clipboard and can
be re-inserted on the label with the “Paste“ command.
The combination of “Cut“ and “Paste“ commands
can be used to speed-up label editing and designing.

Alternatively, you can activate the “Cut“ command
by holding down <Ctrl> and pressing <X> or by clicking

on the  icon on the toolbar.

Copy

Use the Copy command to copy selected objects
to the clipboard.

Alternatively, you can activate the Copy command
by holding down <Ctrl> and pressing <C> or by clicking

on the  icon.

Paste

Use the “Paste“ command to copy the contents of the
clipboard to a label.  This command can be used
to paste the same information more than once.

This function is very useful if you want multiple copies
of the same object on a label.  Once an object has been
designed, it can be copied to the clipboard and pasted
on to the label several times, if desired; each copy of the
object can then be moved to different locations.

You can also activate the “Paste“ command by holding

down <Ctrl> and pressing <V> or by clicking on the 
icon.

Delete

Use the “Delete“ command to delete selected objects
on the active label.

Deleted objects are not stored in the clipboard.  To re-
store deleted objects, the “Undo“ command must be used
before taking any further action.

You can also activate the “Delete“ command by pressing
the <Del> key after selecting the object(s) to be deleted.

Select All

Use the “Select All“ command to select all objects on the
active label.

Reference
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View Menu

The commands in the “View“ menu affect the display
of the label or objects on the screen.

Zoom in

Use the “Zoom in“ command for a detailed view
of a part of an element.

Each time you select “Zoom in,“ the displayed picture
is enlarged by 25%.  The rulers are also zoomed.

While the zoomed view is active, all other commands are
executed in the normal way.

Zoom out

The “Zoom out“ command shows a smaller picture
of the label or part of the label.

Each time you select “Zoom out,“ the displayed picture
is reduced by 25%.  Ruler bars are also zoomed.

While the zoomed view is active, all other commands are
executed in the normal way.

Zoom

When you select the “Zoom“ command from this menu,
you can define the zoom factor.  You can choose any
zoom factor from 5 to 2000.

“Zoom to label“ means that the whole label is displayed
as large as possible.  The same can be achieved

by clicking on the  icon.

“Zoom to elements“ means that all the elements are
displayed as large as possible regardless of the label

size.  The same can be achieved by clicking on the 
icon.

“Zoom to page“ means that the whole page is displayed
as large as possible.  The same can be achieved

by clicking on the  icon.

While the zoomed view is active, all other commands are
executed in the normal way.

Snap to character grid

When you activate the “Snap to character grid“ option, a
grid is displayed that matches the character size of the
current default font. Whenever you create or move an
object this will be aligned to that grid automatically.
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Change the default font and then use the command
“Update character grid“ if you want to change the grid
size.

Update character grid

The command “Update character grid” will adapt the
character grid to match the character size of the actual
default font. To use this command, the ‚Snap to character
grid‘ option must be activated.

Toolbox

“Toolbox” contains frequently-used tools to speed up the
design of the labels.

You can use the icons in the “Toolbox” to mark objects,
to add text, pictures, boxes, barcodes or lines to the
label, and to reverse the display of objects or parts
of objects.

The display of the toolbox can be switched on and off.
When on, the toolbox is positioned on the far left of the
computer screen.  You can also move the toolbox to an-
other part of the screen by moving the mouse cursor from
the toolbox background to the desired position on the
screen while holding down the left mouse button.

You can also use the  icon to turn the “Toolbox”
display on or off.

All of the icons in the toolbox activate commands that are
also represented in the Object menu.  The commands are
executed identically, whether activated by menu
command or toolbox icon.

Click on the corresponding icon to activate the desired
tool.  The background of the activated icon is lighter.

 Select

If you want move or rotate an object, you must first select
it using the “Select” tool.  This tool corresponds to the
“Select” command in the “Edit” menu.

You can also use this tool to cancel the selection of
objects (i.e. to de-select all previously selected objects).

See also the “Select“ command in the Object menu
on page 50.

Reference
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,  Text

Select one of these tools to enter text strings, paragraphs
or single characters.

If you click on the icon with the yellow question mark,
the new text object will be variable.  This automatically
activates the “Variable“ option on the first page of the Text
Wizard.

See also the “Text“ command in the Object menu
on page 35.

,  Barcode

Select one of these tools to define barcode parameters
and barcode data.  If you click on the icon with the
yellow question mark, the new barcode object will be
variable.  This automatically activates the “Variable“
option on the first page of the Barcode Wizard.

See also the “Barcode“ command in the Object menu
on page 40.

 Weight block

Use this tool to add data block containing a weighed
value to a label.

See also the “Weight block“ command in the Object
menu on page 38.

 Picture

Use this tool to copy a picture from a graphics file to a
label.

See also the “Graphics“ command in the Object menu
on page 40.

 Box

Use this tool to add a box or frame to the label.

See also the “Box“ command in the Object menu
on page 39.

 Line

Use this tool to add a line to a label.

See also the “Line“ command in the Object menu
on page 40.
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 Inverse

Use this tool to present an inverted image of a selected
object.  Selecting this tool changes black elements
to white and vice versa.

See also the “Inverse“ command in the Object menu
on page 40.

 Rotate

Use this tool to rotate selected objects 90°.  The co-
ordinates of the upper left-hand corner of the selected
objects stay the same when rotated.

To rotate, click on the object to be rotated, then click
on the rotation icon once for each 90°.

When more than one object is selected (either using the
“Select all“ command or by pressing the <Shift> key and
clicking on several objects), a non-printable rectangle
is created around all the selected objects.

In this case as well, the objects are rotated 90°.  The co-
ordinates of the upper left-hand corner of the non-printable
rectangle stay the same.

 Direct zoom

Use this tool to define the zoom factor.  Just mark the
portion of the label that you want to zoom and it will
be maximized on the display.

See also the “Zoom“ command in the View menu
on page 30.

 Undo direct zoom

This command undoes the direct zoom command (returns
the zoom factor to what it was before the direct zoom
command was executed).

Color palette

With the Color palette command in the View menu you
can switch the color palette on and off.  You can also use

the  icon to do this.

In the color palette you can set or change the color of the
selected objects.  Simply click on the desired color in the
palette and the color of the selected object(s) changes.

Click on the first icon (from left) on the color palette
to open the standard Windows dialog box for defining
custom colors.  In this window you can change every
color in the palette.

Reference
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Text tool

“Text tool” contains all frequently used commands to de-
fine and change the following text parameters: font, font
type, font style (bold, italic, underlined) and size.

The font, size and style shown in the “Text tool” are
default values if no object is selected; otherwise they
show the font definition of the selected object.  You can
change the font (size, style) of a selected object
by changing it in the “Text tool”.

The display of the text tool can be switched on and off.
When on, the text tool is positioned at the top of the label
(document) window.  You can move the text tool
to another part of the screen by moving the cursor from
the text tool background to the desired position on the
screen while holding down the left mouse button.

You can also use the  icon to turn the “Text tool” on
or off.

Note: For variable text, only printer fonts can be used,
which is why only these fonts are shown by default.
To view TrueType and other Windows fonts, click on

the  button.

Align tool

The object(s) can be aligned to each other or to the label.

The display of the “Align tool” can be switched on and
off.  When on, the “Align tool” is positioned at the right
border of the computer screen.  You can move the “Align
tool” to another part of the screen by moving the cursor
from the align tool background to the desired position
on the screen while holding down the left mouse button.

Click on the  icon to turn the “Align tool” on or off.

You can also align objects using the “Align“ dialog box,
which is displayed by choosing the “Align“ command
from the pop-up menu or pressing <Ctrl> + <A>.

The alignment command is often used to align multiple
elements to each other.  For example: say you want to
have 2 elements printed one below the other, aligned
to the left border.  To do this, select “Left” horizontal align-
ment.

Note that when several elements are aligned to a speci-
fied position on a label, they may overlap.

With multiple objects marked, you can select the “hori-
zontally/vertically equally spaced” option.  This positions
the objects so that the distance between them is equal in
the horizontal/vertical plane.
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 Top

Aligns two ore more selected object with the top of the
highest object.

If you want to align objects with the top of the label,
press and hold the <Ctrl> key while clicking on the
“Top” icon.

 Bottom

Aligns two or more selected object with the bottom of the
lowest object.

If you want to align object with the bottom of the label,
press and hold the <Ctrl> key while clicking on the
“Bottom” icon.

 Vertical center

Aligns two or more selected object with the vertical center
of all the objects.

If you want to align objects with the vertical center of the
label, press and hold the <Ctrl> key while clicking on the
“Vertical center” icon.

 Left

Aligns two ore more selected object with the left-hand
side of the object furthest to the left.

If you want to align objects with the left-hand side of the
label, press and hold the <Ctrl> key while clicking on the
“Left” icon.

 Right

Aligns two ore more selected object with the right-hand
side of the object positioned furthest to the right.

If you want to align objects with the right-hand side of the
label, press and hold the <Ctrl> key while clicking on the
“Right” icon.

 Horizontal center

Aligns two ore more selected object to the horizontal
center of all the objects.

If you want to align objects to the horizontal center of the
label, press and hold the <Ctrl> key while clicking on the
“Horizontal center” icon.

Reference
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Object Menu

The commands in the “Object“ menu help you define bar-
code, text, box and line elements.

Text

When you select the “Text“ command or click on the 
icon in the “Toolbox”, the cursor is shown with an “A”
symbol.

Move the mouse cursor to the desired position on the
label and click to start entering text on the label.  Press
<Ctrl> + <Enter> to finish.  If you press <Enter> without
holding the <Ctrl> key, a new text line is created.

To change any of text’s properties, double click the text
object.  The “Text Wizard“ dialog box is displayed.

Text Wizard dialog box

The Text Wizard guides you in defining all parameters
for the text object.

“Fixed text“: Select this option to define non-change-
able content for the text object.

“Variable text“: Select this option if you would like to
have variable content in the text object.

“Contents field“: If you selected the “Fixed text” option,
enter the contents of the text object in
this field.

“Font type“: The currently selected font type is shown
in this field.

“Select button“: You can select a font type for this text
object from among the fonts available
(installed) in the system.

Text Wizard - Choosing variable text

If you selected “Variable“ on the previous Wizard page,
you must select the kind of variable you want to use.

Select the “Show all fields“ option to view all the varia-
bles.  Otherwise only the common variables can be
selected.  You can configure the variables to be shown
in either list in the INI file (isi10.ini; isi20.ini).

Click on the “Advanced“ button to customize the script
that is sent to the weighing display and control unit.
Note that this option is recommended only for experi-
enced users who also have extended knowledge of the
weighing display and control unit.

The next dialog box shown depends upon your selection
here.



37

General variable parameters

Each variable has the following general parameters:

“Length“: Maximum length of the variable text.

“Alignment“: Defines whether the text will be justified left,
right or center in the event that the actual
text length is less than the maximum length
allowed.

When all the parameters are set, click on the “Finish“
button to return to the label.  The variable object is now
displayed with the value shown in the Sample field on the
last page of the Text Wizard.  When the label is printed,
the sample string is replaced by the values defined for the
variable.

Note: The parameters described above are available for
every variable.  Other parameters are described below.

Time variable parameters

“No seconds“: If selected, seconds are not included
with time.

Number variable parameters

“With +/-“: The number is shown with a plus (+)
or minus (–) sign.

“No +“: The number is shown with only a minus (–)
sign.

“No +/-“: The number is shown without a plus (+)
or minus (–) sign.

“Pad 0“: If selected, the number is preceded
by zeroes.

Reference
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Weight variable parameters

“More“: Click on this button to open the
Special flags dialog box in which
you can select additional parameters
for the currently selected field.

“With +/-“: The number is shown with a plus (+)
or minus (–) sign.

“No +“: The number is shown with only
a minus (–) sign.

“No +/-“: The number is shown without a plus
(+) or minus (–) sign.

“No Weight ID“: Checks whether or not weight values
are preceded by an identifier
(indicating gross, net or tare weight).

“No unit“: Checks whether or not the weight
unit is displayed.

“Non-verif.digit“: If selected, a non-verified digit
(not valid in legal metrology) is
also shown.

“Special font for non-verified digit“: Select this option
to define a different font size for the non-verified digit; you
can also select “Reverse” to have the non-verified digit
printed inversely (e.g., white on black instead of vice
versa).

Marked withMarked withMarked withMarked withMarked with: If selected, the characters entered will be
used to enclose the value. Left is used for the character on
the left side; Right is used for the character on the right
side. The default is square brackets.

Special flags dialog

This dialog is shown when you click on the “More“ button
in “Text Wizard“ or “Variable Wizard“ dialog box.

You can select the special flags for the current field which
cannot be set in the “Text Wizard“ or “Barcode Wizard“
dialog box.
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Weight block

The “Weight block“ command in the Object menu inserts
a new weight block element on the label.  The default
format includes the weight value and 4 identifiers:
gross (G), net (N), tare 1 (T1), and tare 2 (T2).  For veri-
fied weighing equipment in which the displayed value d
is not equal to the verified value e, the non-verified value
is displayed inversely.  If you wish to remove one or more
identifiers (for example, to show only the net weight), you
must edit the weight block.

Double-click on the weight block to edit its format.  This
starts the “Weight Block Wizard“:

In the first field, “Weight Block options”, select the weight
identifiers to be included on the label.  You can select
from the following options:

– “Net == Gross”
The weight is shown as a net value, with the identifier
“N”.

– “Gross, Net, Tare1”
The weight is shown with the three identifiers G, N
and T1.

– “Gross, Net, Tare1, Tare2”
The weight is shown with the four identifiers G, N, T1
and T2.

The Mark W Mark W Mark W Mark W Mark Weight Lineseight Lineseight Lineseight Lineseight Lines (<, >)(<, >)(<, >)(<, >)(<, >) option enables you to use
the weight information in separate lines of text, not as one
weight block element. If you select this option, the lines
will be enclosed in pointed brackets. The beginning and
ending lines (—— CE [M] ——) are omitted. Each
weight line can be positioned individually on the label.
They must not overlap or they will become invalid
elements (red marking).

Please note that when using line printers (such as the
YDP04IS in the Line mode), you must not change the
order in which weight lines appear. You may change the
vertical spacing between them, but not their order. Also,
do not place any element on the left or right side of the
weight lines when printing to line printers. Here you can
specify the characters that will be used to enclose the
digit. Left is used for the character on the left side; Right is
used for the character on the right side. The default is
square brackets.

In the Non-verified digitNon-verified digitNon-verified digitNon-verified digitNon-verified digit options you can select the
format of the text that is used to highlight the non-verified
digit in the weight value. This option is valid only if the
connected weighing instrument is verified for legal
metrology and has a scale interval d that is not equal to
the verified scale interval e. Which options are available
in this field depends on the type of printer connected and
the selected font (see below). The default setting is
„Marked with [ and ]“.

Reference
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The following options may be available:

– Inverse display (i.e., white on black rather than black
on white, or vice versa)

· Smaller font

· Rectangle around non-verified digit

· Marked with. Here you can specify the characters that
will be used to enclose the digit. Left is used for the
character on the left side, Right is used for the
character on the right side. The default is  square
brackets.

The FontFontFontFontFont field shows the font used in the weight block.
Click the Select Select Select Select Select button to change the type, style
(standard, italic, bold, or bold+italic) and size of the font.
You can use only printer resident fonts. Otherwise, an
error message is displayed and the label is not printed.

Click the FinishFinishFinishFinishFinish button to close this dialog.

Box

Adds a box or a frame to the label.

When you select the “Box“ command, or click on the 
icon in the “Toolbox”, the cursor is shown with
a “Box” symbol.

Click on the label where you want to position the upper
left-hand corner of the box.  The box appears with drag
handles that you can use to re-size or re-position the box.

To change the box’s properties, double-click on it.  The
“Wizard“ dialog box appears.

Here you can change the thickness of horizontal and
vertical lines by entering new values.  You can set diffe-
rent values for the horizontal and for vertical lines.

Line

To add lines to a label, click on the  icon in the
“Toolbox” or select the “Line“ command from the Object
menu.

Position the mouse cursor at the point where you want
the line to start, then hold down the mouse button while
moving the mouse to draw the line.

You can draw a line horizontally on the label.  If you
want a vertical line, you must rotate a horizontal line.
To do this, select the line object and then click on the
“Rotate” icon in the toolbox.

To change the line width, select the line and move the
drag handles.
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Inverse

Adds an inverted box to the label.  The inverted box turns
all the black objects in the selected portion of the label
to white and vice versa.

When you select the “Inverse“ command, or click on the

 icon in the “Toolbox”, the cursor is shown with the
“Invert” box.

Click on the label where you want to position the upper
left-hand corner of the invert box.  The invert box appears
with drag handles that you can use to re-size or re-posi-
tion the invert box.

Graphics

Sartorius NICE Label Express lets you import graphics
in the following formats:

*.BMP, *.PCX, *.WMF, *.GIF, *.PUT and *.JPG.

When you select the “Graphics“ command from the
Object menu, the “Open“ dialog box is opened.  You

can also use the  icon from the toolbox.  This dialog
is also displayed when you double click on a graphic,
allowing you to change a graphic object that is already
on the label.

A list of graphic files in the default folder
“C:\ProgramFiles\Europlus\SartoriusExpress\Graphics“
is displayed.

You can shorten the list by limiting the types of files
shown.

When you select a file by clicking on it, it is shown on
the “File name“ field.

If you want to open the file from another folder or drive,
use the Windows browse function or enter the full file-
name (including path) in the “File name“ field.

When the “Preview“ option is selected, the picture from
the selected file is shown in the lower left-hand corner of
the “Open“ dialog box.

Once you are satisfied with the selected file, click on the
“Open“ button to add the graphic to the label.

Barcode

When you select the “Barcode“ command, or click

on the  icon in the “Toolbox”, the cursor is shown
with a barcode symbol.

Move the mouse cursor to the desired position of the label
and click to open the “Barcode Wizard“ dialog box.

Reference
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Barcode Wizard

First, click on the “Define“ button to set the barcode para-
meters.  The “Edit Barcode“ dialog box will guide you
through the settings.

Write the numbers/characters to be encoded into the
“Barcode data“ field.  Note that some barcode types only
allow input of numbers or upper-case letters, or only
a precise number of digits.

All settings for variables are identical to those in the Text
Wizard.  The only difference is that the variable value
will be used to generate the barcode instead of just
displaying a value, as in a text object.

When you are satisfied with the settings, click on the
“Finish“ button to add the barcode object to the label.

Edit barcode

In the “Edit barcode” dialog box you can define the
barcode type and properties you want to use.

Select the “Enable preview“ option to view the different
barcode types.

To accept the changes and return to the Barcode Wizard,
click the “OK“ button.

This dialog box contains several property pages, which
are described separately below.

General properties

Click on the “General” tab to set general properties.
Select the desired barcode type from the “Available
barcodes“ pull-down menu.  You can choose one-dimen-
sional or two-dimensional barcodes.  Note that different
barcode types have different requirements; for instance,
some allow only numbers to be encoded, while others
allow only upper-case characters.  For further information
on the various barcode types, contact your supplier.

The barcodes types available are:

One-dimensional:

– EAN 13, EAN 8, UPC A, UPC E
– Interleaved 2 of 5, Code 39, Codabar, Bookland,

Code 93
– Code 128, Code 128-A, Code 128-B,

Code 128-C
– UCC/EAN 128
– Postnet-32, Postnet-37, Postnet-52, Postnet-62

Two-dimensional:

– PDF 417
– DataMatrix
– MaxiCode
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Define the barcode dimensions in the “Barcode dimen-
sions“ field.  The height is set in cm by entering the
desired number in the “Symbol height“ field.  The width
of the barcode is set as the X Expansion factor.  Note that
the width can only be set in pre-defined increments.

When you change barcode dimensions directly on the
screen by moving the drag handles, the new dimensions
are also shown in this dialog box.

Some barcode types allow also the definition of Narrow-
to-wide bar ratio.  You can only choose from the pre-
defined ratios in the pull-down menu – 1:2, 1:3 or 2:5.

The base element width (mils) is calculated automatically
from the X expansion factor.

With thermal and thermal-transfer printers, the barcode
is printed using internal commands.  In this case, the data
below the barcodes is printed using the printer’s standard
font.  When Print barcode as a graphic is selected,
Sartorius NICE Label Express prepares the barcode,
including the text, as a graphic and sends the data
to the printer.  In this case, you have more options when
defining auto-translation of the barcode.  Note that
printing is much slower when Print barcode as a graphic
is selected.

Auto translation properties

“No interpretation“ means that the contents of the bar-
code will not be written as numbers or characters above
or below the barcode.

“Below barcode“ means that the interpretation will be
written under the barcode symbol.

“Above barcode“ means that the interpretation will be
written above the barcode symbol (valid only for Book-
land barcode types)

“Include check digit“ defines whether the checkdigit
(if selected on the Security tab) will be interpreted or not.

If the barcode is printed as a graphic, you can select any
font to print the interpretation.  Click on the “Font“ button
to open the dialog box where you can select the font, in-
cluding type and size.

Auto font scaling can be selected if the barcode
is printed as a graphic.  The size of the selected font
is automatically adjusted to the size of the barcode.

Reference
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Security properties

Include check digit: Some barcodes must have check-
digits (i.e.  EAN 8, EAN 13, UPC A and UPC B);
with other barcode types, you can define a checkdigit.

The checkdigit can be either user-defined or calculated
and generated automatically by the program.  If you want
the program to calculate the checkdigit, select
“Auto CD generation“.

Select the “Verify“ option if you want to enter the check-
digit, and only have it verified by the software.

If Custom checkdigit algorithm is selected, you can define
you own algorithms for calculating the checkdigit.  Click
on the “Select“ button to open the Algorithms dialog box;
here you can define a new algorithm or select an existing
one.

See the “Algorithms dialog box“ for details.

Details page

Click on the “Details” tab to set other barcode para-
meters.

Include quiet zones means that Sartorius NICE Label
Express will insert the necessary free space before and
after the barcode symbol by drawing an unprinted box
around the barcode symbol on the screen.

Descender bars: With EAN 13, EAN 8, UPC A and
UPC E you can print longer first, middle and last bars
when this option is selected.

Mirror horizontally: If the barcode will be printed as a
graphic and has no interpretation, it can be mirrored
along the horizontal axis.

Mirror vertically: If the barcode will be printed as a
graphic and has no interpretation, it can be mirrored
along the vertical axis.

Settings in the “Edit barcode” dialog box for specific
barcode types

UCC/EAN128 barcode

This barcode is combined from one or more input values
and standard application identifiers (AID).  Each AID
must be followed by standard values, which can be fixed
or variable.

When the UCC/EAN 128 barcode is selected, the Bar-
code data field in the Barcode Wizard dialog box is
disabled.  To define the contents of the barcode, click
on the “Next“ button.
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Select the first identifier from the list of available applica-
tion identifiers.  It will be written in brackets below the
barcode.

If the application identifier includes a checkdigit, you
have to define whether it will be calculated or entered
together with data.

Next you need to set the values for the selected identifier.

The “Wizard“ dialog box will tell you what to enter;
i.e., that maximum number of digits.

The defined AID is presented on the list of selected appli-
cation identifiers.  Click on the “Add“ button to add a
new AID or on the “Delete“ to delete an existing one.

If you want to change the AID and the data, select the
AID and click on the “Edit“ button.

You can sort the list of AID by using the “Up“ and “Down“
buttons.

All the settings can be viewed on the “Preview“ field.

You can define the separator between application identi-
fiers by entering the required separator for the left and
right sides of the application identifier.  The default
separator is a bracket.

When you are satisfied with the settings, click on the
“Finish“ button to put the UCC/EAN 128 barcode on the
label.

PDF 417 barcode

General properties

Y expansion factor defines the height of the barcode
symbol.

Security properties

According to the standard, you can choose from 9 levels
of security.  A higher security level allows more reliable
reading regardless of errors, but the barcode symbol
is larger.

Truncated barcodes can be used where it is unlikely that
the label will be damaged and there is no need for very
high security.  The truncated symbol is smaller.

Aspect Ratio

This is the ratio between number of columns and number
of rows.

Contents

PDF 417 code can encode:

– all 128 ASCII characters
– all 128 extended ASCII characters
– 8-bit binary data

Reference
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DataMatrix barcode

General properties

Y expansion factor defines the height of the barcode
symbol.

Aspect Ratio

This is the ratio between number of columns and number
of rows.  Enter the desired value in the fields.

Details

ECC Type: Error Correction Codes define the security
level.  You can select one of the standard levels in the
pull-down menu.

Format ID defines which character set will be used in the
barcode.  You can select a format with one of the
following filters:

01 and 11: 0..9, space
02 and 12: A..Z, space
03 and 13: A..Z, 0..9, space
04 and 14: A..Z, 0..9, space,.-/
05 and 15: 7-bit ASCII lower part (from 0 to 127)
06 and 16: all
07 and 17: 7-bit ASCII

The formats from 1 to 7 allow the data lengths of up to
500 characters, while formats from 11 to 17 allow up to
2000 characters.

Border Size: factors from 1 to 15 set the dimensions
of the border in the shape of the character “L”.

Contents

Data Matrix can encode:
– All ASCII characters
– All ISO characters
– All EBCDIC characters

MaxiCode barcode

General properties

Y expansion factor defines the height of the barcode
symbol.

Details

When the option Structured is not selected, the content
of the barcode is optional.

For Structured barcodes you may encode only standard
contents.
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UCC/EAN128 Wizard

This Wizard makes it easy to define the EAN128 data-
base functions.  Step-by-step instructions are given in the
following.  Click the “Next“ button to advance to the next
screen when the selection you have made on the current
screen is correct.  The “Back“ button returns you to the
previous screen.

Step 1: Choosing an application identifier

The dialog on the first page of the Wizard allows you
to define UCC/EAN128 barcode parameters.

Choose one of the application identifiers from this list.
You can add, edit or delete application identifiers later
in the process.

Step 2: Calculating a Checkdigit

If you have selected EAN Article Number/Shipping
Container or EAN Article Number of Goods as an
application identifier in the “Choosing application
identifier“ dialog, another dialog box appears in which
you can select:

– Automatic calculation: Choose this option to have
Sartorius NICE Label Express calculate the checkdigit
automatically.

– Check digit to be entered with data: Choose this
option to manually enter the checkdigit with data.

Reference
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Step 3: Entering values for the application identifier

You must enter a value for the application identifier.  The
number of required digits is indicated below the input
field.

Step 4: List of selected application identifiers

In the last Wizard page you can add, edit or delete
application identifiers and define separators between
them.

– Application identifiers selected: All application
identifiers selected for the barcode are listed in
this field.  You can change the order of application
identifiers by selecting one and then using the up
or down arrow.

– Add, Edit or Delete buttons: With these buttons you
can add application identifiers and edit or delete
existing ones.

– Input application identifier separator: Here you can
define left and right separators between different
Application Identifiers.

– Preview: A sample of the barcode content is shown
here.

Click on the “Finish“ button to exit the Wizard.

Algorithms dialog box

Sartorius NICE Label Express allows you to create your
own checkdigit algorithms.  This function is very useful
if you want to add your own security measures to protect
barcodes.  Checkdigit algorithms can be defined directly
in the barcode definition, or in conjunction with the
checkdigit algorithm function.

When you select this command the Algorithms dialog box
is opened.
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You can add new or edit and delete existing algorithms
by clicking on the corresponding buttons.  Algorithm
parameters are defined in the Edit algorithm dialog box,
which contains the following options:

– Algorithm name: Name of the algorithm.  Each
algorithm must have a unique name.

– Algorithm description: Brief description of the
algorithm.

– Modulus: See below for explanation.
– Weight(s).
– Sum determination
– Result complemented
– One digit only.

To understand all parameters, you have to know how
checkdigit is calculated.  First of all, we must have
a numeric value from which the checkdigit will be
calculated.  Then the values are weighted.  Let us look
at EAN13, for example:

Value: 123456789012

Weight(s): 1, 3

When calculation starts, each digit has its weight.
When only two weights are specified, the third digit gets
the first weight, forth the second, and so on.  If only one
weight is specified, all digits have the same weight.  The
“Sum determination” box defines whether we use weights
(sum of the products) or not (sum of the digits).
The EAN13 algorithm uses products, so we define
“Sum of the products.”

Our sum is: 1x1 + 2x3 + 3x1 + 4x3 + 5x1 +...  + 2x3

When the sum is calculated, we divide the sum by the
modulus parameter; the remainder of this division may
already be the result (see below).

If Result complemented is selected, we subtract the result
from modulus-1.  If the resulting value is less than 10, this
is the checkdigit.  If it is a two-digit value, either the
lowest digit (One digit only) or the whole value is used as
the checkdigit.

Reference
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Select

The “Select“ command in the Object menu allows you
to select an object on the screen.  After you choose this
command, position the mouse cursor on the desired
object and click on the left mouse button to select it.
You can also activate this command from the Toolbox.

To select two or more objects, press and hold the <Shift>
key while clicking on the objects with the mouse.

The objects can be selected, cut, copied, pasted and
edited with the right mouse button.  If you click the right
mouse button on the object, a menu shows the available
commands.  Note that these commands are equivalent
to the corresponding main menu commands.

Editing objects

If you want to change anything on the objects, double-
click on the object to open the dialog box for setting
object parameters.

Position and size

Select the object and move the drag-handles to re-size the
barcode.

To move an object, select it and move the mouse while
holding down the left mouse button.

Rotation

Most objects can be rotated.  To do this, select the object

and then click on the  icon.  The object is rotated 90°
clockwise.

Popup menu

If you press the right button on the mouse, a special pop-
up menu appears allowing you to quickly select the most
often-used commands.

The content of the pop-up menu depends on where the
mouse cursor is positioned and what was selected at the
time.

Note that this is just a more convenient way of choosing
commands.  The command itself is executed just as if it
was chosen from a main menu or the toolbar.
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Options Menu

The commands in the “Options“ menu help you choose
various options (depending on version of the program).

Language

You can change the language used in the application
with this option.  The application must be restarted before
changes take effect.

Window Menu

The commands in the “Window“ menu help you arrange
the position of currently open windows (documents).

Cascade

Use this command to cascade all open windows.

Note: Make sure all the windows you want to display are
open; minimized windows will not be included in
the cascaded display.

Tile

Use this command to tile all open windows within the
working space.

Note: Make sure all the windows you want to display are
open; minimized windows will not be included.

Arrange Icons

Use this command to arrange icons (minimized windows)
along the bottom of the working space.  This only works if
the icons are not already arranged.

Close All

This command closes all open labels (documents); you
will be asked whether you want to save labels that have
been edited since the last save operation.  Use this
command to close all windows quickly with a single
command (otherwise you have to use the “Close“
command in the File menu for each label (document).

Reference
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Window list

When one or more labels (documents) are open, they are
listed at the bottom of this menu.  You can quickly switch
between windows by selecting the desired window from
this list.  If more than nine windows
are opened, others are accessible under the command
“More windows...“.

Help Menu

The commands in the Help menu help you work with the
program and offer detailed information on the functions.

Contents

This command opens the Help contents.

Using help

This command opens Windows Help, which explains
how to use Help files.

About

This command displays information about the application,
current version and current user.

If you click on the “More“ info button, an expanded
“About” window is displayed with information on each
module (DLL) used by Sartorius NICE Label Express.
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If this does not solve the problem, quit all applications,
restart Windows and start Sartorius NICE Label Express
again.

“This is not a placeable metafile! Can not be loaded!“:
Sartorius NICE Label Express can import only Aldus meta-
files.  This is format which is used in Microsoft Clipart and
other popular software packages.  The standard WMF
format does not contain the size of the metafile.

“This label has been created with a new version of the
software! Please contact your SW supplier to purchase
a new version!“:   This error message is self-explanatory.

Printing

“Printer does not print“:
– Check the installation of the printer driver.
– Make sure the printer driver is associated with the

correct port (on the computer or on the weighing
display and control unit ).

– Make sure the printer is connected to the correct port.
– Make sure the printer is switched on.

“Automatic printer setup failed!“:  See below, “Printer
does not support stock paper format”.

“No printer installed!“:  Sartorius NICE Label Express can
not operate if there is no printer installed.  Please install
a printer first.  You can do this in the “Printers” section
of the Windows Control Panel (under “Settings”).  For
detailed information, see the Microsoft Windows User’s
Guide.

“Printer does not support stock paper format.  This stock
cannot be loaded!“:  Whether stock can be loaded de-
pends on the paper size.  Example: If the active printer
is “LaserJet III P“, an A4 laser printer, and the stock is
defined for A3 paper, you cannot load this stock.

“Printer not installed!“:  Sartorius NICE Label Express can
not operate if there is no printer installed.  Please install
a printer first.  You can do this in the “Printers” section
of the Windows Control Panel (under “Settings”).  For
detailed information, see the Microsoft Windows User’s
Guide.

“Printing (simulating) is in progress! Please finish printing
first!“:  You cannot end the application while it is printing
or showing a print preview.

Troubleshooting

Error Messages

General error messages

“Contents of text or barcode can not be empty.  You must
enter the value for text or barcode!“:  This is self-explana-
tory.

“Contents must not be empty!“:  This is self-explanatory.

“Invalid checkdigit!“:  Some barcodes include a check-
digit in their contents.  If you specify content which con-
tains a checkdigit that is not correct, this error occurs.

“Invalid contents for barcode!“:  Barcodes have some
restrictions on their contents.  For example, an EAN13
barcode must have exactly 12 characters if checkdigit
calculation is automatic, or 13 digits if the value includes
the checkdigit.  In this case, the 13th character must be
the correct checkdigit.  Other barcodes, such as
CODE39, have restrictions on the character set that can
be used for barcode contents.  Check other error mes-
sage pages for detailed information.

“Invalid data for barcode!“:  Some barcodes have a
numeric format; some have their own format (CODE39).
If the value has characters which are not valid for that
format, an error occurs.  In this case, change the value.

“Invalid graphics format!“:  Supported formats are BMP,
WMF, PUT, PCX, GIF and JPEG.  If the format of the
graphic you wish to insert is not one of these, you cannot
include it on the label.

“Invalid INI file!“:  This message appears when the appli-
cation is not properly installed.  In this case, you must re-
install the application.  If the error persists, contact your
supplier or Product Support for assistance.

“Invalid length for barcode!“:  Some barcode types have
restrictions on the length of contents.  If you try to assign a
value which does not have the proper length, an error
occurs.  In this case, enter a different value.

“Invalid picture!“:  Pictures (variables) must have correct
values.  A date picture must contain D, M, and Y charac-
ters, together with ‘/’ and ‘.’.  If any other characters are
in the picture, it is invalid.

“Old contents no longer valid! Invalid characters re-
moved!“:  When you change a font, it may happen that
the selected font does not support all the characters that
were in previous contents of the text.  All invalid charac-
ters are removed from the contents.

“Out of memory while creating new object.  Quit one or
more applications!“:  A problem occurred with the avail-
able memory while creating a new object.  The program
may have run out of memory.  The best solution is to save
your work and quit one or more other applications before
continuing to work with the labeling software.

Troubleshooting
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Weighing display and control unit error messages

“You have manually modified the script.  Do you want
to keep the current script?“:  This warning is shown when
you have made changes in the label script file (*.SCR).
Select “OK“ if you are sure that the modifications are
correct.

“You have manually modified the sample value.  Do you
want to keep the current value?“:  This warning is shown
when you have made changes in the sample value field.
Select “OK“ if you are sure that the modifications are
correct.

“Download module cannot be located!“:  This error
message is shown when there is a problem with installa-
tion of Sartorius NICE Label Express.  It indicates that a
DLL file required for communication with the weighing
display and control unit cannot be found.

“Download function not found!“:  This error message
is shown when there is a problem with installation of
Sartorius NICE Label Express.  It indicates that a DLL file
required for communication with the weighing display
and control unit cannot be found.

“Indicator software version is not the same as NICE
Label’s.  If you have problems during download, please
contact technical support!“:  The software on the
weighing display and control unit is a different version
than one selected in label setup.  There may be problems
when downloading and executing scripts.

“Only printer’s internal fonts can be used for variable
fields! Please select another font!“:  For variable fields,
you can only select the printer’s internal fonts.  No True
Type or other Windows fonts can be used.

“Only printer’s internal barcodes can be used for variable
fields! Please redefine the barcode!“:  For variable fields,
you can only select printer’s internal barcodes.  This error
message indicates that you have selected a barcode that
is not implemented in your printer, therefore NICE Label
Express has sent a bitmap image of the barcode instead.
However, this does not work if the weighing display and
control unit is connected to printer.

“TrueType fonts cannot be assigned to variable field(s)!
Font is not changed!“:  For variable fields, you can only
select printer’s internal fonts.  No TrueType or other
Windows fonts can be used.

“Label was created with other version of NICE Label.
Labels with variables cannot be used in Sartorius NICE
Label Express!“:  This error usually indicates that you have
tried to open a file that was not created with the same
version of NICE Label as the version you are using.  The
file cannot be opened.

“Compile module cannot be located!“:  This error
message is shown when there is a problem with installa-
tion of Sartorius NICE Label Express.  It indicates that a
DLL file required for communication with the weighing
display and control unit cannot be found.

“Compile function not found!“:  This error message
is shown when there is a problem with installation of
Sartorius NICE Label Express.  It indicates that a DLL file
required for communication with weighing display and
control unit cannot be found.

“There were errors during compiling! Please check the
script file!“:  The script file has errors.  Please check the
script file and make the necessary modifications.

“There were errors during download“:  Download was
not completed successfully.  Please try again.

“Label must be saved before exporting to terminal!“:
Before you can export the label to the weighing display
and control unit, the label must be saved.
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Data Printouts for Use in
Legal Metrology

Data Printouts for Use in Legal Metrology

The “NICE Label Express” software from Sartorius can
be used to format printouts that are compliant with
regulations governing legal metrology.

The NICE Label program comes with a special type-
approved module, the “FLEXWB.DLL” file, which lets you
check user-defined printout formats for compliance with
legal metrology regulations.  A print format file that
passes this test is given an electronic approval marker that
cannot be manipulated (see below for details), and a pre-
defined weight block is inserted in the print format.
Without this authentication, asterisks (“***”) are printed
in place of any weight value.

A printout is only valid for legal metrology if it includes
this weight block.  To include the weight block in a print-
out, select the “Weight Block” item from the “Object”
menu.  For details, see chapter 4, “Reference”, in the
NICE Label user’s manual.  You can also configure the
printout to include a user-defined format for weight values,
as well as other data or graphics, if desired.
The only factor that is decisive for the legal metrological
applications is the inclusion of the type-approved weight
block.

Select the “Load” command from the “File” menu to load
a user-defined print file into a terminal or weighing
instrument.  (For details, see chapter 4, “Reference”,
in the NICE Label user’s manual.)  The type-approved
“FlexPrint” software module, which checks the authenticity
of the print file with every printout, is also in the terminal
or weighing instrument.

Which version of FlexWB.DLL you have is indicated
in the operating menu or configuration program of the
weighing instrument in question.

Alternatively, you can contact your nearest Sartorius
representative for assistance.  The Sartorius “Fast Factory”
can reconfigure your user-defined label format to make it
valid for legal metrology.  In this case, however, you
cannot change the print format later.

The test certificate for type-approval of the “FlexPrint”
and “FLEXWB.DLL” modules is shown at the end of this
document.

Weight blocks valid for legal metrology can be
recognized by their headers and footers, which cannot
be reconfigured:

“------ CE [M] ------”

Example of Weight Block Printout:

With taring (2 tare memories):

------ CE [M] ------
B  +      124.45 kg
N  +      100.00 kg
T1 +       24.00 kg
T2 +        0.45 kg
------ CE [M] ------

Without taring:

------ CE [M] ------
N  +      348.65 kg
------ CE [M] ------
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Glossary of Terms

Auto-translation

Barcode interpretation in legible characters.

Quality

The print-head temperature determines the print quality.
The higher the temperature, the darker the printout (ther-
mal printers only).

Descender bars

Longer first and last bar in the EAN 13 barcodes.

Quiet zone

The empty space before and after the barcode symbol.
This is necessary for correct barcode scanning.

Security

The definition of the checksum for some barcode types.

Appendix: Frequently Asked Questions

Using Sartorius Nice Label Express with a
Connected Scale or Indicator

How can I download a print definition to the scale?

§ Connect the serial port of the PC to the data output
port on your scale. Configure the data output in the
scale operating menu to ‘xBPI’ or ‘xBPI-232’. Refer
to the scale operating manual for detailed instructions.

Note
With indicators of the isi series, it is easiest if you have
separate data outputs for printer and PC. This lets you
keep the printer connected to the indicator and download
new print definitions while the application
is running.

§ To begin downloading, select ‘Compile’ from the ‘File’
menu in the ‘Sartorius Nice Label Express’ program
and click on the ‘Download’ button.

I have a PC connected to the scale; why do I get an error
message while connecting or downloading?

§ Check whether the data output is configured to ‘xBPI’
in the scale operating menu (see above).

§ Switch the scale on and make sure it is running in the
basic weighing mode. Exit any applications before
activating the download function.
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Printer / Paper

Predefined Label Stock

After pressing the button “Select Label Stock“ in the Label Setup Wizard you can select predefined label stocks of
different manufacturers.

The following label stocks are distributed by Sartorius:

Stock name Dimensions Distribution No. Preselected Printer

0_056x030 56 x 30 mm 69Y03092 none
0_056x076 56 x 76 mm 69Y03093 none
0_056x100 56 x 100 mm 69Y03094 none
0_101x127 101 x 127 mm 69Y03195 none
1_056x030 56 x 30 mm 69Y03092 YDP01IS
1_056x076 56 x 76 mm 69Y03093 YDP01IS
1_056x100 56 x 100 mm 69Y03094 YDP01IS
1_060xxxx 60 mm Continous 69Y03090 YDP01IS
2_056x030 56 x 30 mm 69Y03092 YDP02IS
2_056x076 56 x 76 mm 69Y03093 YDP02IS
2_056x100 56 x 100 mm 69Y03094 YDP02IS
2_101x127 101 x 127 mm 69Y03195 YDP02IS
2_060xxxx 60 mm Continous 69Y03090 YDP02IS
2_101xxxx 101 mm Continous 69Y03196 YDP02IS

How can I print on continuous paper?

§ Open the Printer Setup dialog in the Label Setup
Wizard (or double-click on the printer name in the
status line).

§ Click on the ‘Advanced...’ button.
Which settings are to be configured depends on your
printer model:
– YDP01IS

Enter a value not equal to 0.00 in the ‘Form Feed’
field. The printer will feed this length instead of
searching for the label gap.

– YDP02IS and YDP04IS:
Select ‘Other’ for ‘Sensor type:’. This will switch
the label sensor of the printer to a paper-end
sensor.

How can I print several identical labels?

In the ‘Compile’ dialogue enter the desired number of
labels in the ‘Quantity’ field. (refer to the section on the
‘Compile’ function in the ‘File’ menu, in the „Reference“
chapter of this manual).

Appendix: Frequently
Asked Questions

How can I use a label printer from another
manufacturer?

There are 2 steps required for using a printer from a
manufacturer other than Sartorius:

§ Download the required printer driver from the
www.nicelabel.com Web site and install the printer
driver in your Windows operating system.

§ Select ‘Universal’ as the printer type in your scale
menu. Make sure the transmission parameters (baud
rate, parity, word length and stop bits) are correct for
the printer in question.

Formatting Printouts

Why is the printout from the YDP01IS printer different
from the screen layout?

The YDP01IS printer has only limited graphic capabilities.
For example, fields can be positioned only line
by line.

If two fields that appear to be on one line on the screen
appear in different lines on the printout, use the alignment
tools in ‘Sartorius Nice Label Express’ to ensure that the
fields are in one line.

You can avoid unnecessary empty lines by placing the
lines as close together as possible.
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Why are there „printer fonts“ in my program that
obviously don’t match those in my label printer?

This can happen if you use additional program tools, such
as the Adobe Type Manager, which install fonts
that appear as ‘printer fonts’ in the application program.
Usually the font name indicates whether a given font can
be used with your label printer.

My print definition file is too large to download to the
scale. What can I do?

Avoid using True Type fonts. Text formatted with True Type
fonts is converted into relatively large graphics. Use
printer fonts of the desired size instead.

If you use logos (graphics) you should use a small size.
You can also use a graphic editor to cut empty margins
off the graphic. This will reduce the amount of graphic
data.

How can I make the printout darker?

§ Open the Printer Setup dialog in the Label Setup
Wizard (or double-click on the printer name in the
status line).

§ Either increase the value in the ‘Darkness’ field,
or decrease the value in the ‘Speed’ field.

Weight Values

What is the weight block for?

Printing the weight block guarantees a printout of the
weight value (gross, net and tare weights) in accordance
with requirements for legal metrology. With verified
weighing instruments, you can still define your own format
for the weight value printout, but the weight block must be
printed as well.

Why are asterisks (***) printed in place of the weight
value on my label?

With verified weighing instruments, you must always print
a weight block. You can also define your own weight
value format, to be printed in addition to the weight
block.

If the space you define for the weight block is too small
— for example, if you have selected the net value for
printing but a tare weight is also used — asterisks (‘***’)
are printed in place of the weight value.

How can I include the weight block on a pre-printed
form that doesn’t have a separate space for it?

In this case, Sartorius can help you. Our ‘Fast Factory’
service can check your pre-printed label and modify it for
use in legal metrology. Contact your local Sartorius office
or dealer for more information.

Bar Codes

How can I print a bar code that contains only the
characters I enter, without extra spaces at the end?

§ Define a bar code variable with the desired maximum
length and enter a full length sample value so you can
check the layout on the screen.

Example:
§ Select the “ID1” field; for example, to print the ID1

(defined in the scale) as an article number.
§ Click on the ‘Advanced...’ button in this Bar Code

Wizard dialog.
§ In the next dialog box, enter a zero (‘0’) in place

of the ‘$l’ (dollar sign followed by a lower-case
‘L’).

> ID1 is now printed without unnecessary spaces
at the end.
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